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Introduction 
 
N1MM Logger+, usually called N1MM+ or just N1MM, is a very powerful logging 
program, constantly updated for free by an open source team of about a dozen people, 
led by Tom N1MM, and including crack contesters, such as Steve London N2IC and 
Richard Ferch VE3KI.  N1MM has very thorough documentation on the web.  Just 
search for the topic of interest and N1MM in Google.  My intention is not to supplant or 
improve that documentation, just get you going quickly in a sort of “guided tour” so you 
know what to look for.  This document is written for hams using N1MM for the first time, 
and explains how to initialize the logger ‘in particular for participating in state QSO 
parties and the State QSO Party Challenge. 
 
N1MM has a user guide for new users: 
<https://n1mmwp.hamdocs.com/getting-started/> 
There are how-to videos that may help: 
<https://n1mmwp.hamdocs.com/support/how-to-videos/> 
 
The purpose of the logger is to generate a log of contacts, automatically entering the 
time and frequency read from the radio via Computer Assisted Transceiver (CAT) 
commands.  The CAT command set for each model of radio is different.  N1MM can 
also automatically generate CW contest exchanges and even can play pre-recorded 
.wav files for SSB contests, although it is hard to tailor these audio messages with serial 
numbers and callsigns of the station you’re working.  If connected to the Internet, N1MM 
can download spots into a bandmap, and facilitate you working new stations and mults.  
You can QSY to spotted stations by clicking on them in the bandmap window.  And 
N1MM can connect to leaderboard websites during the contest to continuously update 
your results. 
 
N1MM is excellent for Single Operator 1 Radio (SO1V i.e. normal operation), Single Op 
2 Radios (SO2R, where you use two radios on two different bands) and Single Operator 
2 VFOs (SO2V, where you have VFO A and VFO B in one radio, and work at two 
different frequencies, typically in one band).  It also works well in multiop situations, 
facilitating each op “logging on” for their shift of the contest.  N1MM can be networked 
among different computers in the same WiFi network, for multi-multi or multi-two 
configurations where two or more different computers attach to individual radios, and 
the log needs to be coordinated. 
 
Checklist for the First Time: 
 
1.  Connect your radio to the N1MM computer using whatever serial 
cable/converter is required between them.   
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(a) Rigs with DE9 9 pin connectors need a USB to RS232 converter cable.  People 
seem to have more success with FTDI chipset rather than Prolific.  See “Everything You 
Need to Know about Serial and USB Interfaces here: 
https://www.kkn.net/~n6tv/N6TV_Dayton_2019_Everything_USB.pdf 
(b) Some QRP radios use a 3.5 mm TRS jack, and only have RS232 Gnd, Tx and Rx.  
You will need a suitable cable and a WinKey or similar device to key the radio for CW, 
or build a circuit from a transistor and resistor if you want to use DTR to key the radio for 
CW (more later). (c) Recent radios may have a USB connector, so you just need a USB 
cable to the computer, like the ICOM 7300, Yaesu FTDX10 and the Elecraft K4.     
 
2.  In the Windows Device Manager, figure out the COM port for your radio’s serial 
interface.  One way is to watch the COM Ports in the Windows Device Manager while 
removing and inserting your radio’s USB connector.  Some radios such as the Icom 
7300, will show a single new COM Port.  For the 7300, look for a COM Port called 
“silicon Labs CP210x USB to UART Bridge”.  Note the COM Port number for later.  
 
The Yaesu 710 and FTDX10 have two COM Ports: 
“Silicon Labs Dual CP210x USB to UART Bridge : Enhanced COM Port (COM5)” 
“Silicon Labs Dual CP210x USB to UART Bridge : Standard COM Port (COM6)” 
I’ve used the COM Port numbers 5 and 6 as examples.  Yours might be different, and 
depends on your computer.  Note the numbers for later. 
The first Enhanced COM Port is used for CAT communications, such as frequency and 
mode settings.  The second Standard COM Port can be used for controlling PTT, CW 
keying and some digital operation. 
 
3.  In the N1MM Entry window, under the Tools menu, select Check for New Program 
Version and Install, to get the latest version. 
 
4.  In the Entry window, under the Config menu, select Change Your Station Data and 
set your station data. This information can be automatically used in some contest 
exchanges (for example, your call sign, ARRL section) and will be added to logs 
(address and email address). 
 
5.  In the Entry window, under the Config menu, select Configure Ports, Mode 
Control, Winkey, etc.  A new pane will open with the Hardware tab showing.  Set the 
Port for your radio’s COM port serial interface, and select your model of radio.  Probably 
you want to click the CW/Other box beside your radio (unless maybe you’re SSB-only, 
or using a Winkey, or have a radio such as Yaesu 710 or FTDX10 that uses a second 
(standard) COM port for CW keying, in which case that second port will have the 
CW/Other box checked.)  Click the Set box beside your radio and set the baud rate  
(data speed) to whatever speed your radio is set.  Usually the recommended settings 
shown in N1MM are correct unless you’ve deliberately changed your radio’s settings.  
Set the DTR to CW and maybe set RTS to PTT, although you probably don’t need this.  
You probably don’t need to touch anything else. 
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By clicking on the CW/Other box and setting DTR to CW, you are setting N1MM to send 
CW characters by using the DTR line as if it is a straight key.  So you need to set your 
radio to accept keying via the DTR line from the CAT control COM Port(s).  Some 
examples: 
 

• On an Elecraft K3, set MENU: PTT-KEY to rtS-dtr or OFF-dtr 
• On an Icom 7300, press Menu, select Set, select Connectors, select USB Keying 

(CW), and select DTR 
• On a Yaesu FTDX10 or 710, in the CW Settings menu, select PC Keying and set 

it to DTR. 
 
(A word about PTT (Push To Talk):  For CW, your radio probably internally generates 
PTT, that is, goes into transmit, when the key or paddles are closed, or when N1MM 
creates a key down signal on DTR of the serial interface.  (Sometimes this requires you 
have VOX enabled while in CW mode on your radio.)  So you don’t need RTS=PTT, or 
any of the PTT via radio command check boxes.  (These send a CAT command to the 
radio to go into transmit.)  For SSB, I’m assuming you’re using VOX or a PTT switch on 
the mic or floor.  However, if you have .wav files recorded in N1MM playing into the 
radio, you may have to use PTT via Radio Command to get a PTT to the radio.  Also, 
Elecraft equipment does well with RTS=PTT for CW.  Sometimes if there are too many 
different things generating PTT, such as internally in the radio plus N1MM PTT via 
Radio Command, you can get weird artifacts such as the radio hanging.) 
 
Click OK to close the Set box. 
 
Now to the right of the Set box, choose SO1V, unless you are going to try using both 
VFOs in your radio (SO2V), or a second radio (SO2R). 
 
You don’t need to bother with other tabs in the Configurer, unless you are using a 
WinKey, or RTTY, or other advanced features. 
 
Also in the Config menu, fifth item down, select Enter Sends Message (ESM) so it 
has a checkmark beside it.  (more later) 
 
6.  In the Entry window, use the Window menu to open the windows you want.  I 
use Bandmap (even if not using spots, for reasons I’ll describe later), Check, Grey Line, 
Info, Log, Multipliers and Score Summary.  You can make an argument for Network 
Status and Telnet depending on what you are doing.  I like the Entry window near the 
middle of the screen nearest the keyboard, at the bottom, with the Log above it and the 
Bandmap oriented vertically to the left of the Entry window.  YMMV.  When you have an 
orientation you like, select Save Window Positions in the Tools menu and then later, 
after someone messes them up, you can use Restore Window Positions to put them 
back.  Also, if there are multiple operators and you use Cntl+O or the OPON command 
(typed in the Entry window) to identify yourself, your windows will move into your 
position (kind of like the individual seat position for each driver in a fancy car.) 
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In general, you can right click on each window to set parameters pertaining to that 
window. 
 
7.  In the Entry window Tools menu, select Download and Install the Latest Country 
File  (6th item) and I like to also Download and Install the Latest Check Partial File (3rd 
item). 
 
8.  Give some thought to ergonomics.  You can tell the Entry window becomes your 
main focus while making Qs during the contest.  I like the keyboard and display centred 
in front of me, with the radio on the left close by so I can change the tuning, RIT and AF 
Gain easily, and look at the Spectrum display on the radio.  I like the mouse and key on 
the right side.  If my screen is too small, I put secondary windows, like the grey line and 
score, on the secondary screen.  Where will you put coffee and snacks?  A pillow can 
increase your “butt in chair” time.  Try to avoid using a pen and paper, but have one 
nearby in case you need to note an error to fix later.   
 
Preparing For a State QSO Party (or any other Contest) 
 
1.  Read the rules.  N1MM knows a lot of the rules automatically, but sometimes sends 
an RST in the contest exchange when it’s not needed, etc.  You’ll hear this on the air 
during the contest.  It’s best to know the official exchange and what you’re supposed to 
be doing instead of relying on N1MM. 
 
2.  In the Entry window File menu, select New Database and create a database for 
the current year, e.g. 2025, where your individual contest logs will be saved.  (I don’t 
always do this but I wish I had.)  Then select New log in Database, and a new Log pane 
will open up.  (If it doesn’t, you may have some stuff typed in to the Entry window and 
the program thinks you’re in the middle of a contact.) 
 
3.  In Log Type, select the contest from the long pulldown menu.  For a State QSO 
Party, select QSOPARTY.  Mid way down the pane is a tab for Contest, and in the 
Contest pane, on the right you will see a pulldown menu of all the QSO parties 
supported by N1MM.  Choose the state or the regional QSO party that you intend to 
work.  The list includes some QSO parties which are not part of the State QSO Party 
Challenge.  All of the QSO parties in the State QSO Party Challenge are supported by 
N1MM. 
 
Different QSO parties have different exchanges.  There are five elements which could 
be included in an exchange for an “out-of-state” participant in a state QSO party.  These 
are: signal report, QSO serial number, your name, your state and your ARRL section.  
For example, the Florida QSO Party uses signal report and your state, which is the most 
common exchange in state QSO parties.  The California QSO Party uses a serial 
number and your state. The Pennsylvania QSO Party uses serial number and your 
ARRL section.  The Minnesota QSO Party uses your name and your state. 
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When you select the specific state QSO party, look at the Sent Exchange box three up 
from the bottom of the pane under the Contest tab.  It will show the elements of the 
exchange (except for signal report, which is added automatically as 5nn when needed.)  
If the Sent Exchange box has an element with a “?” after it, such as MY_NAME? or 
MY_STATE?, you should replace it with your name or state. 
 
For any other contest, select it from the pulldown menu.  If you aren’t sure what 
acronym in the menu pertains to your contest, look at this webpage for the fuller names 
of the contests supported by N1MM: 
https://n1mmwp.hamdocs.com/manual-supported/contests-list/#the-supported-contests-
tables  
 
There are other contest categories you should set in the Contest tab:  Single-op, All 
bands, Power (QRP, Low Power or High Power), Mode (e.g. SSB+CW) and whether 
you are Assisted or Non-Assisted.  If there are multiple operators, you can list them.  
The Soapbox text box puts comments from you into your Cabrillo file, when you 
generate it at the end of the contest, to be passed to the contest organizers.  For 
example, “I had a great time, until my antenna fell down and I had to put it back up in 
the dark.  Good participation, thanks for all you do to organize this great contest.”  I 
never use this, but if you want to, you can fill it out after the contest.   
 
You can always change these parameters (if, say, you decide to change categories by 
increasing your power or by deciding to use spots) during or after the contest by 
selecting Open Log in Database from the File menu during the contest – don’t be 
scared you’ll lose your log.  If you mistakenly select New Log, you can go back to Open 
Log and open your previous log and continue to add QSOs. 
 
4.  While in the New Log pane, note the Associated Files tab beside the Contest tab.  
We’ll come back to this. 
 
5.  Function Keys and the Entry Window.   
This is the heart of using N1MM, so if you’ve been skimming until now, slow down and 
read this carefully.  It will save you learning the hard way like I did. 
 
First, look around the Entry window.  See the bands on the left side: 10m, 15m, etc.?  
They change with the contest and mode, based on what’s eligible.  (If you can’t see 
them, right click on the window and change its options.)  If you click on one of them, 
your radio will change to that band!  If you don’t have CAT control, clicking on one will 
log the bottom frequency of the band into the Log window for each Q, which is good 
enough to submit your Cabrillo log for most contests. (more later) 
 
Look at the Call Sign box and the Exchange boxes beside it.  You start a Q by entering 
the callsign in the Call Sign box.  You move to the Exchange box by typing Space.  
You can move among the boxes with Tab.  But special stuff happens when you move 
from the callsign to the exchange with the space bar: N1MM looks in your log, and in 
your Call History File, to see if it knows any exchange information to automatically load 
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into the exchange box(es).  For example, if you have worked the station on another 
band (if that is legal for the contest) and already know the ARRL section or state, it will 
automatically appear.  Or if you have that station’s info in your Call History File, and 
have enabled Call History in the Tools menu, it will put that info in the exchange box, 
which may be wrong because the person may have moved, or changed their name, etc.  
You still have to listen and verify. 
 
Let’s back up.  Let’s say you’re doing S&P, and you move to a frequency with a spotted 
callsign shown in your bandmap, or maybe you’ve typed his callsign in the entry window 
before, and come back to that frequency, then the callsign will appear above the Call 
Sign box.  It will be grey if you’ve worked it before, and blue if not and red if it’s a new 
mult.  If you hit Enter (and have enabled Enter Sends Message in the Config menu), 
N1MM will send your callsign (more later) and the callsign will be automatically put into 
the Call Sign box.  Then if you hit space, N1MM will fill the exchange boxes if it can.  
Also, if there is no spot, and you type a callsign into the Calls Sign box, the same will 
happen.  Either way, it’s your job to make sure the callsign and exchange is right.  (If 
you have the Check window open, a checkmark will appear beside the callsign to 
indicate N1MM has found it in your log, your call history file, or in spots, or in Super 
Check Partial, a database of most callsigns, which you downloaded using the Tools 
menu.  If you get a question mark instead of a checkmark, verify that you have the call 
sign correct because it’s not recognized as a frequent contester). 
 
Back to our tour of the Entry window.  Under the Call Sign box are two red and green 
dots.  These show which radio has entry focus and transmit focus when doing SO2R 
and SO2V, so we can ignore them for now. 
 
Beside them are “radio buttons” for Run and S&P.  You can click on these, or toggle 
them with Alt+U.  There are different F keys definitions for Run and S&P, and these 
radio buttons show which F key definitions will be used. (more below) 
 
To the right of Run and S&P is the CW speed at which N1MM sends.  This is entirely 
separate from your radio CW speed, so N1MM can blast along at 25 wpm and your 
paddle can provide “fills” (if someone missed the exchange), at say 18 wpm using the 
keyer in your radio.  You can change the N1MM speed by clicking the arrows or typing 
Page Up or Page Down on the keyboard. 
 
F-Keys!  The whole raison d’etre for the logger.  Pushing F1 through F12 sends their 
associated messages, .wav files, and/or executes any macros stored in them.  There 
are separate F key definitions for S&P and Run.  They are activated by pushing the F 
key, or by clicking the box in the entry window, or automagically by N1MM by pushing 
Enter (i.e. Return on your keyboard) if you have Enter Sends Message set in the Config 
menu.  F keys definitions can be viewed and edited by right clicking on the F key box 
area of the Entry window, and a pane will appear. 
 
There is a lot to know about F keys.  You might be tempted to just set a couple of keys 
to some useful stuff you need to send, like maybe F1 is your callsign and F2 is the 
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exchange.  Then you would press these when you need them to send the CW.  
Likewise you could have .wav files recorded to be sent in an SSB contest.  Don’t do it 
this way! 
 
The F keys have standard definitions, used in an N1MM “state machine” where the 
state is advanced by you pushing the Enter key, and dependant on whether you’re in 
Run or S&P: 
 
F1 is the CQ key 
F2 is the Exchange Key  
F3 is the End of QSO (TU) key 
F4 is the “My Call” key 
F5 is the “His Call” key 
 
If you are in S&P, and enter a call in the Call Sign box, you’ll see the F4 button go 
yellow.  The yellow button is what will get sent when you hit Enter (that is, Return).  So, 
if you hit Enter you’ll send your callsign.  Then you hit space (and maybe the exchange 
will automatically be entered) to enter the exchange they send to you.  You’ll see your 
F2 button turn yellow.  When you hit Enter, N1MM sends your F2 exchange.  (Typically 
this is TU followed by the exchange.) 
 
In Run mode, F1 (the CQ message) is yellow, so when you hit Enter, you’ll call CQ.  If 
you hit Alt+R during a CQ it will turn on auto CQ Repeat, repeating after 3 seconds of 
listening.  Alt+R toggles it off.  After a CQ, if you get an answer and type it in the Call 
Sign box, you’ll see F5 (his call) and F2 (exchange) light up yellow.  If you hit Enter, 
N1MM will send his call followed by the exchange.  Hit Space and (maybe the exchange 
will automatically enter from call history or a previous QSO or) you enter the exchange.  
You will now see F3 (TU) and the Log It buttons lit up yellow.  When you hit Enter, 
N1MM will send the thank you acknowledgement, which may have your callsign 
appended to solicit a new caller, and it will log the Q.   
 
It’s a good habit to watch the buttons to see what is yellow if you have the mental 
bandwidth, just to make sure the Q gets logged, and you don’t send something you 
didn’t intend because of some weirdness.  Weirdness can be that you have a spurious 
character you left in the exchange box from a guy you almost worked, for example. 
 
So now you’re probably feeling ready to right click the F keys and set up your 
messages.  Not so fast, there’s more.  You can download standard F key definitions for 
each contest.  And there is a macro programming language for the F key definitions. 
 
I would start by downloading the standard key definitions.  Go back to the File menu in 
the Entry window, and select Open Log in Database (or New Log in Database if you 
haven’t started defining the contest yet.)  You’ll see your contest category information.  
Look for the Associated Files tab about half way down the pane, and click it.   
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This tab shows function key definition files and call history file associated with this 
contest.  Go to the change box beside the appropriate Function Key Filename (CW, 
SSB or digital) or the call history file.  For most contests, such as CQWWCW you click 
the Change box, it will first give you an opportunity to download N1MM’s latest file from 
their site, with their filename.  If you click No, it will take you to the appropriate N1MM 
directory on your computer, and give you an opportunity to select among your own 
previously stored files (.mc for function key definitions, and .txt for call history files.)   
 
However, with QSO Parties, there is no .mc F Key file tailored to each state QSO party 
available from N1MM.  Your choices are to use the standard F Key definitions in the file 
CW Default Messages.mc or tailor those messages yourself.  Before we dig into the 
definitions for the F Keys in the CW Default Messages.mc and how to tailor them, let me 
be more clear about the decision you are making.  The CW Default Messages.mc file 
relies on the contents of the Exchange box in the Contest tab to send the proper 
exchange for the contest, such as signal report and state for the Vermont QSO Party 
and your name and state for the Minnesota QSO Party.  If you like all the other 
elements of the CW Default Messages.mc, then you might be happy with relying on the 
Exchange box to specialize your F Keys for each state QSO party.   
 
Or you can tailor the F Key definitions for each individual state QSO party when you set 
it up, then export it using the Export menu item in the File menu in the Entry window, 
and give it a name like Vermont_QSOparty_CW.mc.  If you then open the contest in the 
File menu and select that file in the Associated Files tab, N1MM will forever associate it 
with the Vermont QSO party. 
 
My approach is to tailor the F Key definitions, and export them, for four different flavours 
of state QSO parties:  those that use signal report and state, those that use name and 
state, those that use serial number and state, and those that use serial number and 
ARRL section.  I give them file names I can understand and remember.  When I set up 
a new state QSO party for the first time, I click the Change box in the Associated Files 
tab and select the appropriate .mc file for CW.  N1MM then remembers that .mc file 
when I come back to do the same state QSO party next year. 
 
While you are in the Associated Files tab you should also click the Change button 
beside Call History and download the latest version of the Call History file available 
from N1MM if there is one. 
 
Now lets talk about how to tailor the F Key definitions in .mc files, initially for CW then 
for SSB messages. 
 
You can hardwire the F key definitions for CW by changing F1, for example, to “CQ test 
VE3YT”, and set F2, the exchange, to “5nn Vic ON”.  It’ll work, and N1MM will send that 
CW to your radio.  By the way, if you leave two spaces between words, it’ll send two 
spaces.  If you want a half-dot space, type ~.  Sometimes I use VE3Y~T on F6 to make 
the Y and T just a bit more distinct, for people who hear dah di dah dah dah on F4. 
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There are some macros and special characters you can use in the F Key definitions.  
Anything in curly braces {} is an N1MM macro.  But there are single character macros 
that don’t need curly braces.  Here’s the macros I use most often: 
 
* sends my call 
{MYCALL} sends my call 
! sends his call (whatever is entered in the Call Sign box) 
{EXCH} sends the Exchange as defined in the Contest pane.  (SS is special, because 
      you’ll have to “hardwire” your Precedence, Check and Section in the F2 definition.) 
# sends your current serial number of the QSO 
{LOG} causes the QSO to log.  (You might have an F Key set for logging.) 
{WIPE} clears the Call Sign box and Exchange box(es)  
{RUN} puts you in Run mode 
{S&P} puts you in S&P mode, handy for sprints were the messages change 
{CAT1ASC} sends an ascii CAT command to the radio (e.g. Elecraft) 
{CAT1HEX} sends a hex CAT command to the radio (e.g. Icom) 
{SENTRSTCUT} Sends the RST you enter in the exchange box as a “cut number”.  In 
     cut numbers, 9 is an N.  I never use this, I just put 5NN right in the F2 definition when  
     the contest exchange has a signal report. 
There are many more macros in the N1MM documentation, to do things like zero your 
RIT, etc. 
 
Special characters: 
 
>  reduces the CW speed by 2 wpm.  These can be concatenated like >>> 
<  increases the CW speed by 2 wpm. 
~  inserts a half dot of space 
 
Any other text just gets sent as a normal CW letter. 
 
Here is the CW Default Messages.mc file provided by N1MM: 
 
################### 
#   RUN Messages  
################### 
F1 Cq,Cq Test {MYCALL} {MYCALL} 
F2 Exch,{SENTRSTCUT} {EXCH} 
F3 Tu,Tu {MYCALL} 
F4 {MYCALL},{MYCALL} 
F5 His Call,! 
F6 Repeat,{SENTRSTCUT} {EXCH} {EXCH} 
F7 Spare, 
F8 Agn?,Agn? 
F9 Nr?,Nr? 
F10 Call?,Cl? 
F11 Spare, 
F12 Wipe,{WIPE} 
# 
# 
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################## 
#   S&P Messages  
################### 
F1 Qrl?,Qrl? de {MYCALL} 
F2 Exch,{SENTRSTCUT} {EXCH} 
F3 Tu,Tu 
F4 {MYCALL},{MYCALL} 
F5 His Call,! 
F6 Repeat,{SENTRSTCUT} {EXCH} {EXCH} 
F7 Spare, 
F8 Agn?,Agn? 
F9 Nr?,Nr? 
F10 Call?,Cl? 
F11 Spare, 
F12 Wipe,{WIPE} 
 
F Key definitions use while in Run mode and while in S&P mode are specified 
separately.  Let’s look at the F1 Key in Run mode: F1 Cq,Cq Test {MYCALL} {MYCALL} .   F1 
specifies the F1 Key.  The Cq before the comma is the label put on the box for the F1 
Key under the Call Sign box in the Entry window.  You could change this to CQ, or CQ 
Run, and see the label change on the box.  The stuff after the comma is actually sent by 
your radio when you activate the F1 Key (either by pressing F1 or clicking on the box in 
the Entry window or by using Enter to send the F1 message when it is highlighted.)  
Your radio will send CQ Test, then it will interpret the macros {MYCALL} {MYCALL} as a 
request to get your call sign from the Station Data and will send your call sign twice.  If 
you are calling CQ in the Vermont QSO Party (and you are not in Vermont), you 
probably want to send CQ VT then your call sign once, rather than CQ Test.  So you 
could change this line to be F1 CQ,CQ VT {MYCALL}, or just type in your call sign 
instead of the macro.  Your call sign is also represented by the symbol *, so you could 
type F1 CQ,CQ VT * 
 
Let’s assume you’re S&P in the Vermont QSO Party, and you’re not in Vermont.  When 
you tune to a Vermont station calling CQ VTQP, you will automatically have the F4 
button highlighted.  You would enter their callsign in the Call Sign Box in the Entry 
window, then press Enter to send F4 which is set to send {MYCALL} once, to send your 
call sign.  Then hit space and N1MM will enter the Vermont station’s county in the 
Exchange box if it has that information in a Call History file, or will wait for you to enter it 
(or correct the pre-fill) from what you hear on the air.  N1MM will also highlight the F2 
box under the Call Sign Box so that when you hit return it will send your exchange as 
defined by the F2 Key definition in the .mc file.  You can see above that F2 is specified 
to be F2 Exch,{SENTRSTCUT} {EXCH} which will send the Cut Numbers version of the 
signal report, that is 5nn, followed by whatever you have defined in the Exchange box in 
the Contest pane when you set up the contest, which is probably your state.  Or, you 
could just change the definition in the .mc file to read F2 Exch,5nn OH if you are in 
Ohio. 
 
When you are logging the running station’s county, it is important to use the proper 
county abbreviations specified by the QSO party organizers (often available on their 
website) and “baked into” N1MM.  If you use a different abbreviation, N1MM won’t 
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accept it.  So it is good practice to print out the abbreviations in advance, especially for 
phone contacts where the runner sometimes gives the full name of the county instead of 
the abbreviation. 
 
If the runner is on a county line, they might give two counties.  These can be entered 
into N1MM as a single exchange with the counties separated by a “/” (slash).  N1MM 
will log two QSOs, one for each county, with the same call sign and time.  Some 
runners on county corners might give three or even four counties, which can all be 
separated by slashes. 
 
So what about SSB?  The Associated Files pane when you set up the contest has a 
separate .mc file for SSB, and uses it when your radio is in SSB mode.  The F Keys can 
send .wav files, following the same state machine logic based on Enter Sends 
Message.  Normally you keep the .wav files in this directory, where you replace my 
callsign with your own: 
 
C:\Users\{username}\Documents\N1MM Logger+\Wav\VE3YT 
 
You record messages for CQ.wav, Thanks.wav, Mycall.wav, QRZ.wav, and whatever 
else you want, and put them in that directory.  (Use Audacity, or try recording directly in 
N1MM by going in Run or S&P, then typing Ctrl+Shift+FKey to start recording, and 
Ctrl+Shift+FKey to stop.  Make sure to identify you are the Operator in the log when you 
start the contest, using the OPON command in the Call Sign box, or the Ctrl+O 
command, and use the same callsign as the directory for the recordings.  (This permits 
multiple ops to have their own recordings in multiops.  Probably you can get rid of the 
{Operator} macro and the callsign in the directory, but I’ve never tried it.  Here are 
typical F-Key definitions:  
 
Run F Keys: 
F1 CQ,{OPERATOR}\CQ.wav  
F2 Exch,{OPERATOR}\Exchange.wav  
F3 TNX,{OPERATOR}\Thanks.wav  
F4 {MYCALL},{OPERATOR}\Mycall.WAV  
F5 His Call,empty.wav  
F6 Spare,empty.wav  
F7 QRZ?,{OPERATOR}\QRZ.wav  
F8 Agn?,{OPERATOR}\AllAgain.wav  
F9 Exchg?,{OPERATOR}\Exchange query.wav  
F10 Spare,empty.wav  
F11 Spare,empty.wav  
F12 Wipe,{WIPE}  
 
S&P F Keys 
F1 CQ,{OPERATOR}\CQ.wav  
F2 S&P Exch,{OPERATOR}\S&P Exchange.wav  
F3 Spare,empty.wav  
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F4 {MYCALL},{OPERATOR}\Mycall.WAV  
F5 His Call,empty.wav  
F6 {MYCALL},{OPERATOR}\Mycall.wav  
F7 Rpt Exch,{OPERATOR}\Repeat Exchange.wav  
F8 Agn?,{OPERATOR}\AllAgain.wav  
F9 Spare,empty.wav  
F10 Spare,empty.wav  
F11 Spare,empty.wav  
F12 Wipe,{WIPE} 
 
Or, you can use {CAT1ASC} or {CAT1HEX} macros in F Key definitions to play 
messages recorded in the radio.  Here are some examples for different radios: 
 
For an ICOM 7300 you could set F1 as follows: 
F1 CQ, {CAT1HEX FE FE FE 94 E0 28 00 01 FD}   to play the message recorded in 
memory 1. 
F2 Exch, {CAT1HEX FE FE FE 94 E0 28 00 02 FD}  will play the message recorded in 
memory 2.  (Hopefully the exchange is constant, without a serial number specific to 
each Q.) 
F4 MyCall, {CAT1HEX FE FE FE 94 E0 28 00 04 FD}  will play the message recorded 
in memory 4, which could be your call sign. 
 
In general in for the 7300, change the two digits before the FD to anything between 01 
and 08 to play the messages recorded in memory 1 to memory 8.  If you want an F Key 
that instantly stops the message being played, say by pressing F11, then set its 
definition to F11 ESC, {CAT1HEX FE FE FE 94 E0 28 00 02 FD}   I labeled this ESC 
because you also use the ESC button to stop N1MM CW messages midway through. 
 
For a Yaesu 710 or FTDX10, you could use the following macros to play 
messages: 
F1 CQ, {CAT1ASC PB01;} will play the message recorded in memory 1. 
F2 Exch, {CAT1ASC PB02;} will play the message recorded in memory 2.  
There are five voice message memories in these radios, available by using PB0#: 
where # is between 1 and 5.  You could set F4 MyCall, {CAT1ASC PB04;} to send the 
recording of your call sign in memory 4. 
To stop playing a message, you could set F11 ESC, {CAT1ASC PB00;} to send the 
command to the radio to end voice message playback. 
 
For an Elecraft K3: 
If you have the Digital Voice Recorder option, there are four voice messages, triggered 
from the front of the radio by tapping the switches in a circle.  These CAT Macro strings 
will play back the DVR voice keyer messages by emulating a tap of those switches: 

• M1 = {CAT1ASC SWT21;} 
• M2 = {CAT1ASC SWT31;} 
• M3 = {CAT1ASC SWT35;} 
• M4 = {CAT1ASC SWT39;} 
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So you could use M1 for CQ, M2 for Exchange and M4 for you call sign by typing in the 
following F Key definitions: 
F1 CQ, {CAT1ASC SWT21;} 
F2 Exch, {CAT1ASC SWT31;} 
F4 MyCall, {CAT1ASC SWT39;} 
 
6.  Multiple State QSO Parties on the Same Weekend 
Some weekends have multiple state QSO parties with overlapping time periods, or 
there may be other contests you want to enter simultaneously.  Each of these requires 
an individual log in N1MM and then you switch among these as you work individual 
stations in different contests. 
 
Set up an individual log in your database for each QSO party using New Log in 
Database from the File menu in the Entry window.  Be sure to set the exchange box 
properly for each contest, and choose the appropriate .mc files and Call History files in 
the Associated Files tab for each one.  N1MM will remember these on a per contest 
basis and will change the F Key messages and the call history file as you switch among 
contests. 
 
There are two ways to switch among contest logs. Click on the File menu in the Entry 
window and you will see a list of the last nine contest logs you created at the bottom of 
the pane that pops up.  You can select other logs there by clicking on them.  You can 
also select logs from this list by typing ALT+F to open the pane, then typing a number 
from 1 to 9 to select a log.  So, if you have two logs, you can toggle between them by 
typing ALT+F then 2. 
 
One big weekend, in early May, has four QSO parties: the 7th Call Area, New England, 
Indiana and Delaware.  N1MM has an integrated logger for this contest called XXX.  
Each of the four QSO parties will accept this integrated log included QSOs for the other 
three.  However, to post your results on www.3830scores.com for each individual QSO 
party, as required for the State QSO Party Challenge, you will need to tease your log 
apart to get the number of Qs, mults and score for each individual QP.  The parsing tool 
at http://www.b4h.net/cabforms/multiqplogparser.php will do this automatically for you. 
 
7.  Bandmap Window 
The Bandmap window has more value than just spots.  If you turn your radio on and off, 
but leave your computer on, you will have to watch for a “Reset Radio” notification at the 
bottom of the Bandmap window.  If you do not click this notification button to reset the 
connection to the radio, you will not log the proper frequency to which the radio is tuned.  
In fact you may be on a different band, which can mess up your scoring and the logger’s 
ability to detect duplicate callsigns (“dupes”). 
 
There are also rectangular buttons near the top of the Bandmap window which can be 
programmed with macros to send CAT commands to the radio.  If your radio has a rich 
programming language and no ability to store sufficient macros internally, these four 
programmable buttons can be useful. 
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8.  Online Scoreboards 
 
Online Scoreboards, sometimes called leader boards, allow contesters and others to 
watch the progress of contest participants in real time.  You can configure N1MM to 
automatically upload your results periodically to contestonlinescore.com or 
cqcontest.net or any other online scoreboards that can get information from the online 
score distributor server.  In the Entry window, under the Config menu, select “Configure 
Ports, Mode Control, Audio, Other…”  and click on the “Score Reporting” tab.  Click the 
box for “Report Real-Time Score to Server”.  At the present time, the pulldown menu for 
the Score Reporting Server lets you choose score distributor server (which connects to 
other online scoreboards) or specifically to contestonlinescore.com or cqcontest.net.  
Put in your username and password for the Contest Online ScoreBoard site, or the 
cqcontest.net site, or whatever site you are using.   
 
 
9.  After the Contest – Submitting the Log 
After the contest, to participate in the State QSO Party Challenge, it is important to 
submit your score to www.3830scores.com which is how the State QSO Party 
Challenge gets your information.  Within a few minutes you should see your score 
reflected on the State QSO Party leaderboard, which can be accessed by selecting 
Leaderboards from the menu near the top of this page https://stateqsoparty.com/sqp-
challenge-results/ 
 
On www.3830scores.com it is important to select your contest club so that your 
participation also counts towards that club’s results in the State QSO Party Club 
Challenge. 
 
To participate in the Worked All QSO Parties program, you need to submit your 
log to the QSO party organizers for each QSO party in which you participate.  
Just submitting to 3830 isn’t sufficient. To create the Cabrillo format version of your 
log to submit to the contest organizers select Generate Cabrillo File in the Entry window 
File menu.  N1MM will ask if your exchange is defined correctly for inclusion in the log.  
(If not, you can go back to the File menu, select Open the Log and change it on the 
Contest pane.)  Then it will ask if your category is correct and also valid for the contest.  
(If not, you can Open the Log and change it too.) 
 
N1MM will then give you a file save window in which you can choose a directory and 
filename.  I suggest using filenames that include the year and contest type, such as 
2025 Florida QP.log.  You don’t need your name or callsign in the filename for the 
organizers to know whose log this is. 
 
The .log Cabrillo files are actually .txt files so you can open them in a text editor and see 
what is in the header (such as your name, callsign, address and category) and even edit 
these. 
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To figure out where to submit the Cabrillo file, I use the WA7BNM contest calendar at 
www.contestcalendar.com and select the contest to see its detailed description, which 
always has the URL for log submission.  These log submission pages usually ask a few 
questions about your power level, in or out of state, number of operators, etc., to 
determine your category independently of the Cabrillo header, and then give you a way 
to browse your filesystem to identify the file to upload.  You often get an email from a 
log checking robot that has done a preliminary check on your log, with a confirmation of 
submission. 
 
The State QSO Party Challenge website has a detailed checklist for submitting your 
results to 3830, your log to the organizers, and then adding the log to your global log, to 
QRZ and to LOTW.   
 
10.  Digital Modes – RTTY and FT8/FT4 
Don AA5AU has done a great job of explaining how to set up various programs with 
N1MM for RTTY and FT8/FT4 contesting. 
<https://www.rttycontesting.com/tutorials/n1mm/plus/> for RTTY, and 
<https://www.rttycontesting.com/tutorials/n1mm/operating-ww-digi-with-n1mm/> for 
FT8/FT4. 
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7.  Shortcut Keys 
 
Essential: 
Alt+w  Wipe log entry 
Ctrl+o  Set Operator callsign in log (or enter OPON in Call Sign box) 
Alt+u  Toggle S&P and Run 
Ctrl+k Enter or exit CW text window (type text and it sends as CW, close it to use 

the other logger functions)  
ESC  Stops sending 
Page Up CW speed up 
Page Down CW speed down 
Alt+r  Toggle CQ Repeat 
Alt+Enter Log Q without sending anything (Only works in ESM Mode) 
 
I Use Mouse Clicks or Button Pushes Instead of These: 
Ctrl+r  Set CQ Repeat interval time 
Ctrl+n  Add note to log 
Ctrl+d  Delete last logged QSO 
Ctrl+q  Quick edit last QSO 
Alt+F10 Swap VFOs 
Alt+F8  Return to last frequency 
Alt+q  Return to last CQ frequency if in S&P 
 
Split Shortcuts: 
Ctrl+Enter Set Split frequency 
Crtl+s  Enter Split Mode 
Crtl+Alt+S Toggle Split Mode on and off 
Alt+F7  Set Split frequency or offset to specified frequency 
 
SO2V and SO2R Shortcuts: 
\  Change receive focus among Entry windows 
PAUSE Swap both receive and transmit/keyboard focus among Entry windows 
`  Toggle receive both VFOs/radios on and off 
Alt+F5  Swap frequencies between Entry windows (VFOs/radios) 
Crtl+Enter Send next ESM State on “other radio” 
Crtl+F1 to F12 Send F Key message on “other radio” 
Crtl+B  Toggle Duelling CQs on and off 
 
 
 
 
  
 
 


